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Introduction
One of the requirements when using FPGA devices is the ability to calculate power dissipation for a particular 
device used on a board. Lattice’s ispLEVER® design tools include a Power Calculator tool which allows designers 
to calculate the power dissipation for a given device. This technical note explains how to use Power Calculator to 
calculate the power consumption of Lattice devices. General guidelines to reduce power consumption are also 
included.

Power Supply Sequencing and Hot Socketing
LatticeECP™, LatticeEC™ and LatticeXP devices have eight sysIO™ buffer banks in addition to the VCC, VCCAUX
and VCCJ power supplies; each is capable of supporting multiple I/O standards. Each sysIO bank has its own I/O 
supply voltage (VCCIO), and two voltage references VREF1 and VREF2 resources allowing each bank to be com-
pletely independent from each other. 

The LatticeECP/EC and LatticeXP devices are designed to ensure predictable behavior during power-up and 
power-down. Power supplies can be sequenced in any order. The I/Os remain in tristate until the power supply volt-
age is high enough to ensure reliable operation during power up and power-down sequences and the leakage into 
I/O pins is controlled to within specified limits. Refer to the Typical I/O Behavior During Power-up and Hot Socketing 
sections of the device data sheet for more details.

Power Calculator Hardware Assumptions
The power consumption for a device can be coarsely broken down into the DC portion and the AC portion. 

The power calculator reports the power dissipation in terms of:

1. DC portion of the power consumption.
2. AC portion of the power consumption.

The DC power (or the static power consumption) is the total power consumption of the used and unused resources. 
These components are fixed for each resource used and depend upon the number of resource units utilized. The 
DC component also includes the static power dissipation for the unused resources of the device.

The AC portion of power consumption is associated with the used resources and it is the dynamic part of the power 
consumption. Its power dissipation is directly proportional to the frequency at which the resource is running and the 
number of resource units used.

Power Calculator
Power Calculator is a powerful tool which allows users to make an estimate of the power consumption at two differ-
ent levels:

1. Estimate of the utilized resources before completing place and route
2. Post place and route design

For first level estimation, the user provides estimates of device usage in the Power Calculator Wizard and the tool 
provides a rough estimate of the power consumption.

The second level is a more accurate approach where the user imports the actual device utilization by importing the 
post Place and Route netlist (NCD) file. 

Power Estimation and Management for 
LatticeECP/EC and LatticeXP Devices



Power Estimation and Management 
for LatticeECP/EC and LatticeXP Devices

12-2

Power Calculator Equations
The power equations used in the Power Calculator have the following general form:

Total DC Power (Resource)
= Total DC Power of Used Portion + Total DC Power of Unused Portion
= [DC Leakage per resource when Used * NRESOURCE] 

+ [DC Leakage per resource when Unused * (NTOTAL RESOURCE - NRESOURCE)]
Where:

NTOTAL RESOURCE is the total number of resources in a device.
NRESOURCE is the number of resources used in the design.

The total DC power consumption for all the resources as per the design data is the sum of Quiescent Power and 
the individual DC power of the resources in the Power Calculator.

Total DC Power (ICCAUX) 
= KRESOURCE * 500 µA + Typical Standby ICCAUX

Where:
KRESOURCE is the number of reference input I/O such as HSTL/SSTL. For LVDS KRE-

SOURCE is number of inputs divided by two.
ICCAUX is a DC current that does not change with I/O toggle rate or temperature.

Typical Standby ICCAUX is found in the data sheet.

The AC power, on the other hand, is governed by the equation:

Total AC Power (Resource) 
= KRESOURCE * fMAX * AFRESOURCE * NRESOURCE

Where:
NTOTAL RESOURCE is the total number of resources in a device.
NRESOURCE is the number of resources used in the design.
KRESOURCE is the power constant for the resource, measured in mW/MHz.
fMAX is the maximum frequency at which the resource is running, measured in MHz.
AFRESOURCE is the activity factor for the resource group, as a percentage (%) of switching 

frequency.

Based on the above equations, if we wish to calculate the power consumption of the Slice portion, it will be as fol-
lows:

Total DC Power (Slice)
= Total DC Power of Used Portion + Total DC Power of Unused Portion
= [DC Leakage per Slice when Used * NSLICE]

+ [DC Leakage per Slice when Unused * (NTOTAL SLICE - NSLICE)]

Total AC Power (Slice) 
= KSLICE * fMAX * AFSLICE * NSLICE

The DC and AC power, for a dedicated block, like DSP in LatticeECP devices, is governed by the following equa-
tions.

Total DC Power (Resource)
= DC Leakage per Resource * NRESOURCE
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Total AC Power (Resource)
= KRESOURCE * fMAX * NRESOURCE

Where:
NRESOURCE is the total number of resources in a device.
KRESOURCE is the power constant for the resource, measured in mW/MHz.
fMAX is the maximum frequency at which the resource is running, measured in MHz.

Starting the Power Calculator
The user can launch the Power Calculator by one of the two methods. The first method is by clicking the Power Cal-
culator button in the toolbar as shown in Figure 12-1.

Figure 12-1. Starting Power Calculator from Toolbar

Alternatively, users can launch the Power Calculator by going to the Tools menu and selecting the option Power 
Calculator as shown in Figure 12-2.
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Figure 12-2. Starting Power Calculator from Tools Menu

The Power Calculator does not support some of Lattice’s older devices. The toolbar button and menu item is only 
present when supported devices are selected.
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Starting a Power Calculator Project
Once the Power Calculator has been started, the Power Calculator window appears. Click on File ->Menu, and 
select New to get to the Start Project window, as shown in Figure 12-3.

Figure 12-3. Power Calculator Start Project Window (Create New Project)

The Start Project window is used to create a new Power Calculator Project (*.pep project). Three pieces of data are 
input in the Start Project window.

1. The Power Calculator project name by default is same as the Project Navigator project name. The name 
can be changed, if desired.

2. Project Directory is where the Power Calculator project (*.pep) file will be stored. By default, the file is 
stored in the main project folder.

3. Input an NCD file (if available) or browse to the NCD file in a different location.
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Power Calculator Main Window
The main power calculator window is shown in Figure 12-4.

Figure 12-4. Power Calculator Main Window (Type View)

The top pane of the window shows information about the device family, device and the part number as it appears in 
the Project Navigator. The VCC used for the Power Calculation is also listed. Users have an option to provide the 
ambient temperature, and the junction temperature is calculated based on that.

Users can also enter values of airflow in Linear Feet per Minute (LFM) along with heat sink to get the junction tem-
perature. A table in the top part of the Power Calculator summarizes the currents and power consumption associ-
ated with each type of power supply for the device. This also takes into consideration the I/O power supplies.

In the middle pane of the window, there are two tabs:

1. Power View
2. Report

The first tab is the Power view. Under this tab, the Power Calculator tool has an interactive spreadsheet type inter-
face.
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The second and third columns, which are shaded blue in the tool, provide the DC (or static) and AC (or dynamic) 
power consumption, respectively.

In case of the I/O, there are four columns that are shaded blue. These provide the DC and AC power for I/Os for the 
core voltage, VCC and the I/O voltage supply, VCCIO.

The first three rows show the Quiescent Power for VCC, VCCAUX and VCCJ.These are DC power numbers for a blank 
device or device with no resource utilization.

Some of the cells are shaded yellow in the tool. These cells are editable cells and users can type in values such as 
frequency, activity factors and resource utilization.

The second tab or the Report tab is the summary of the Power View. This report is in text format that provides the 
details of the power consumption.

The final pane or the lower pane of the window is the log pane where users can see the log of the various opera-
tions in the Power Calculator.

Figure 12-5. Power Calculator Main Window (Power Report View)
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Power Calculator Wizard
The Power Calculator Wizard allows users to estimate the power consumption of a design. This estimation is done 
before actually creating the design. The user must understand the logic requirements of the design. The wizard 
asks the user to provide these parameters and then estimates the power consumption of the device.

To start the Power Calculator in the wizard mode, go to the File menu and select Wizard. Alternatively, click on the 
Wizard button and get the Power Calculator - Wizard window, as shown in Figure 12-6. Select the option Create 
a New Project and check the Wizard check box in the Power Calculator Start Project window. Users provide the 
project name and the project folder and click Continue. Since power is being estimated before the actual design, 
no NCD file is required. 

Figure 12-6. Power Calculator Start Project Window (Using the New Project Window Wizard)

The next screen, as shown in Figure 12-7, allows users to select the device family, device and appropriate part 
number. After making proper the selections, click Continue. This is shown in Figure 12-7.
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Figure 12-7. Power Calculator Wizard Mode Window - Device Selection

In the following screens, as shown in Figures 12-8-12-12, users can select further resources such as I/O types and 
provide a clock name, frequency at which the clock in running and other parameters, by selecting the appropriate 
resource using the pull-down Type menu:

1. Routing Resources
2. Logic
3. EBR
4. I/O
5. PLL
6. Clock Tree

The numbers in these windows refers to the number of clocks and the index corresponds to each of the clocks. By 
default, the clock names are clk_1, clk_2, and so on. The name of each clock can be changed by typing in the 
Clock Name text box. For each clock domain and resource users can specify parameters such as frequency, activ-
ity factor, etc. Users can click the Create button for each clock-driven resource using the pull-down Type menu.

These parameters are then used in the Power Type View window (see Figure 12-13) which can be seen by clicking 
Finish.
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Figure 12-8. Power Calculator Wizard Mode Window - Resource Specification - Logic

Figure 12-9. Power Calculator Wizard Mode Window - Resource Specification - EBR
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Figure 12-10. Power Calculator Wizard Mode Window - Resource Specification - PLL

Figure 12-11. Power Calculator Wizard Mode Window - Resource Specification - Routing Resources
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Figure 12-12. Power Calculator Wizard Mode Window - Resource Specification - I/Os

Figure 12-13. Power Calculator Wizard Mode - Main Window
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Power Calculator – Creating a New Project Without the NCD File
A new project can be started without the NCD file by either using the Wizard (as discussed above) or by selecting 
the Create a New Project option in the Power Calculator – Start Project. A project name and project directory 
must be provided. After clicking Continue, the Power Calculator main window will be displayed.

However, in this case there are no resources added. The power estimation row for the Routing resources is always 
available in the Power Calculator. Users are then asked to add more information like the slice, EBR, I/O, PLL and 
clock tree utilization to calculate the power consumption.

For example, to add logic resources (as shown in Figure 12-14), right-click on Logic >> and then select Add in the 
menu that pops up. 

Figure 12-14. Power Calculator Main Window – Adding Resources

This adds a new row for the logic resource utilization with clock domain as clk_1.

Similarly, other resources like EBR, I/Os, PLLs and routing can be added. Each of these resources is for AC power 
estimation and categorized by clock domains.
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Power Calculator – Creating a New Project With the NCD File
If the post place and routed NCD file is available, the Power Calculator can use it to import the accurate information 
about the design data and resource utilization and calculate the power. When the Power Calculator is started, the 
NCD file is automatically placed in the NCD File option, if available in the project directory. Otherwise, the user can 
browse to the NCD file in the Power Calculator.

Figure 12-15. Power Calculator Start Project Window – With Post Place and Route NCD File

The information from the NCD file is automatically inserted into the correct rows and the Power Calculator uses the 
Clock names from the design, as shown in Figure 12-16.
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Figure 12-16. Power Calculator Main Window – Resource Utilization Picked Up From the NCD File
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Power Calculator – Open Existing Project
The Power Calculator – Start Project window also allows users to open an existing project. Select the option Open 
Existing Project and browse to the *.pep project file and click Continue. This opens the existing project in similar 
windows as discussed above. This is shown in Figure 12-17.

Figure 12-17. Opening Existing Project in Power Calculator



Power Estimation and Management 
for LatticeECP/EC and LatticeXP Devices

12-17

Power Calculator – Total Power
The Power Calculator project created or opened using any of the methods discussed here would allow a user to 
calculate the power consumption for the device running with their design. 

The estimated power is indicated in the Total section at the bottom of the table as shown in Figure 12-18.

Figure 12-18. Calculated Power in the Power Calculator Main Window

The second and third columns from the left indicate the DC (or static) and AC (or dynamic) power consumption. 
The total power consumption for the design can be seen in the same table. Scroll down to the row labeled Total. 

Activity Factor
Activity Factor % (or AF%) is defined as the percentage of frequency (or time) that a signal is active or toggling of 
the output.

Most of the resources associated with a clock domain are running or toggling at some percentage of the frequency 
at which the clock is running. Users are required to provide this value as a percentage under the AF% column in 
the Power Calculator tool.
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Another term used for I/Os is the I/O Toggle Rate or the I/O Toggle Frequency. The AF% is applicable to the PFU, 
Routing and Memory Read Write Ports, etc. The activity of I/Os is determined by the signals provided by the user 
(in the case of inputs) or as an output of the design (in the case of outputs). So, the rates at which I/Os toggle 
define their activity. The Toggle Rate (or TR) in MHz of the output is defined as:

Toggle Rate (MHz) = 1/2 * fMAX * AF%

Users are required to provide the TR (MHz) value for the I/O instead of providing the Frequency and AF% in case 
of other resources.

The AF can be calculated for each routing resource, output or PFU, however it involves long calculations. The gen-
eral recommendation of a design occupying roughly 30% to 70% of the device is that the AF% used can be 
between 15% to 25%. This is an average value that can be seen most of the design. The accurate value of an AF 
depends upon clock frequency, stimulus to the design and the final output.

Ambient and Junction Temperature and Airflow
A common method of characterizing a packaged device’s thermal performance is with thermal resistance, . For a 
semiconductor device, thermal resistance indicates the steady state temperature rise of the die junction above a 
given reference for each watt of power (heat) dissipated at the die surface. Its units are °C/W.

The most common examples are JA, thermal resistance junction-to-ambient (in °C/W) and JC, thermal resis-
tance junction-to-case (also in °C/W). Another factor is JB, thermal resistance junction-to-board (in °C/W). 

Knowing the reference (i.e. ambient, case or board) temperature, the power, and the relevant  value, the junction 
temperature can be calculated as per following equations.

TJ = TA + JA * P (1)
TJ = TC + JC * P (2)
TJ = TB + JB * P (3)

Where TJ, TA, TC and TB are the junction, ambient, case (or package) and board temperatures (in °C) respectively. 
P is the total power dissipation of the device.

JA is commonly used with natural and forced convection air-cooled systems. JC is useful when the package has 
a high conductivity case mounted directly to a PCB or heatsink. And JB applies when the board temperature adja-
cent to the package is known.

The Power Calculator utilizes the 25°C junction temperature as its basis to calculate power, per Equation 1 above. 
Users can also provide the airflow values (in LFM) and ambient temperature to get a calculated value of the junc-
tion temperature based on the power estimate. 

Managing Power Consumption
One of the most critical design factors today is reducing system power consumption, especially for modern hand-
held devices and electronics. There are several design techniques that designers can use to significantly reduce 
overall system power consumption. Some of these include:

1. Reducing operating voltage.

2. Operating within the specified package temperature limitations.

3. Using optimum clock frequency reduces power consumption, as the dynamic power is directly proportional 
to the frequency of operation. Designers must determine if a portion of their design can be clocked at a 
lower rate that will reduce power.

4. Reducing the span of the design across the device. A more closely placed design utilizes fewer routing 
resources for less power consumption.
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5. Reducing the voltage swing of the I/Os where possible. 

6. Using optimum encoding where possible. For example, a 16-bit binary counter has, on average, only 12% 
Activity Factor and a 7-bit binary counter has an average of 28% Activity Factor. On the other hand, a 7-bit 
Linear Feedback Shift Register could toggle as much as 50% Activity Factor, which causes higher power 
consumption. A gray code counter, where only one bit changes at each clock edge, will use the least 
amount of power, as the Activity Factor would be less than 10%.

7. Minimize the operating temperature, by the following methods:
a. Use packages that can better dissipate heat. For example, packages with lower thermal impedance.
b. Place heat sinks and thermal planes around the device on the PCB.
c. Better airflow techniques using mechanical airflow guides and fans (both system fans and device 
mounted fans).

Power Calculator Assumptions
Following are the assumptions made in the Power Calculator:

1. The Power Calculator tool is based on equations with constants based on room temperature of 25°C.

2. The user can define the Ambient Temperature (Ta) for device Junction Temperature (Tj) calculation based 
on the power estimation. Tj is calculated from user-entered Ta and power calculation of typical room tem-
perature.

3. The I/O power consumption is based on output loading of 5pF. Users have ability to change this capacitive 
loading. 

4. The current version of the Power Calculator allows users to get an estimate of the power dissipation and 
the current for each type of power supplies, that are VCC, VCCIO, VCCJ and VCCAUX. For VCCAUX, only static 
ICCAUX values are provided in the Calculator. 

Additional VCCAUX contributions due to differential output buffers, differential input buffers and reference 
input buffers must be added per pair for differential buffers or per pin for reference input buffers according 
to the user's design. See the equation given in this technical note for Total DC Power (ICCAUX).

5. The nominal VCC is used by default to calculate the power consumption. Users can choose a lower or 
higher VCC from a list of available values. For example, the nominal VCC of 1.2V is used by default for the 
LatticeECP/EC and LatticeXP families of devices.

6. The current versions also allows users to enter an airflow in Linear Feet per Minute (LFM) along with the 
Heat Sink option to calculate the Junction Temperature.

7. The default value of the I/O types for the LatticeEC and LatticeXP devices is LVCMOS12, 6mA. 

8. The Activity Factor (AF) is defined as the toggle rate of the registered output. For example, assuming that 
the input of a flip-flop is changing at every clock cycle, 100% AF of a flip-flop running at 100MHz is 50MHz.

Technical Support Assistance
Hotline: 1-800-LATTICE (North America)

+1-503-268-8001 (Outside North America)

e-mail: techsupport@latticesemi.com

Internet: www.latticesemi.com
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Revision History
Date Version Change Summary

June 2004 01.0 Initial release.

July 2004 01.1 Provided additional description of the assumptions used in the power 
model.

October 2004 01.2 Updated screen shots for ispLEVER 4.1.

February 2005 02.0 Added support for LatticeXP family throughout.

Added DC and AC power for a dedicated block like DSP for LatticeECP 
devices.

May 2005 02.1 Updated the Power Supply Sequencing and Hot Socketing section.

Updated the total DC Power consumption to be sum of Quiescent and 
the DC power of resources.

November 2006 02.2 Added calculation of ICCAUX in Power Calculator Equations section.

September 2007 02.3 Document title changed to “Power Estimation and Management for Lat-
ticeECP/EC and LatticeXP Devices”.

September 2012 02.4 Updated document with new corporate logo.
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Appendix A. Power Calculator Project Example
This example assumes that you have post Place and Route NCD netlist in the design folder. Click on File > New or 
click on the New Project button. The New Project Window will open as shown below.

The various fields are filled in automatically with the project name the same as the ispLEVER project name and the 
directory also the same as the design folder. If the Post Place and Route NCD file is available, the NCD File field is 
also automatically filled. Users can also browse to the particular location to change the folder where they wish to 
create the Power Calculator project. Users can also browse to the NCD file in case it is not available at the root 
design folder.

Click Finish. This opens the Main Power Calculator project window, as shown below.

Note that the project window above imports all the resource utilization information from the NCD file. It does not, 
however, include information such as the frequency at which the design is operating or the activity factors at which 
the various components are toggling. This information is to be filled in by the user.

The top portion of the Power Calculator window shows information such as the device family and device being con-
sidered for power calculation, the VCC, which is by default the nominal VCC for the device, and operating conditions. 
Operating conditions users can enter include the ambient temperature, and heat sink available. Users can also 
select the air flow values.

There is a grayed box for junction temperature that shows Tj based on the given conditions and the calculated 
power.

If we assume the design is running at 100 MHz with a 10% Activity Factor, the final Power Calculator will be as 
shown below.
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